
Coiled-Tubing Stress Analysis Model 
Stress/Drag/Hydraulic/Buckling 

Theory and User's Manual 

MAURER ENGINEERING INC. 
2916 West. T.C. Jester Boulevard 

Houston, TX 77018-7098 

Telephone: 7131683-8227 Telex: 216556 
Facsimile: 71316834418 

August 1993 
TR93-11 

This copyrighted 1993 confidential report and the computer prognm are for the soleuse 
of Participants on the Drilling Engineering Associalion DEA-67 project to DEVELOP 
AND EVALUATE SLIM-HOLE AND COILED-TUBING TECHNOLOGY and their 
a K i t e s ,  and are not to be discbsed to other partiec. Data output from this program 
can be dbcbsed to thud parties. Participants and tbeir a K i t e s  are free to make copies 
of this report and programs for their own use. 





Table of Contents 

Page 

1 . INTRODUCTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1 

1.1 Model Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1 

1.1.1 General Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1 
1.1.2 Drag Force. Axial Load. and Triaxial Stress . . . . . . . . . . . . . . .  1-1 
1.1.3 Hydraulics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2 
1.1.4 Buckling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2 
1.1.5 Tortuosity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2 

1.2 COPYRIGHT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2 

1.3 DISCLAIMER . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2 

2 . THEORY AND EQUATIONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1 

2.1 AXIAL DRAG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2.1 
2.1.1 Introduction to the Variables . . . . . . . . . . . . . . . . . . . . . . . .  2-1 
2.1.2 Derivation of the Equations . . . . . . . . . . . . . . . . . . . . . . . . .  2-2 

. . . . . . . . . . . . . . . . . . .  2.1.3 Consideration of Multi-Element Cases 2-2 

2.2 APPLYING THE DRAG MODEL TO A STRING OF COILED TUBING 2-3 

2.2.1 Physical S i  and Weight . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3 
2.2.2 Spatial Orientation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3 
2.2.3 Nature of Motion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3 
2.2.4 Loads at the Bottom of Each Element . . . . . . . . . . . . . . . . . . .  2-3 
2.2.5 Loads at the Top of the Coiled Tubing . . . . . . . . . . . . . . . . . . .  2 4  
2.2.6 Friction Factor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2 4  
2.2.7 Cable Load . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2 4  

2.3 AXIAL STRESS AND LOAD . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2.5 
2.3.1 Load at Bottom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-5 
2.3.2 Axial Load . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-5 
2.3.3 Hook Load . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2 4  
2.3.4 Axial Stress . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2 4  
2.3.5 Axial Load and Axial Drag . . . . . . . . . . . . . . . . . . . . . . . . . .  2-7 

2.4 BENDING STRESS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-7 

2.5 HYDRAULICS ANALYSIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-8 

2.5.1 Bingham Plastic Model . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-8 
2.5.2 Power-Law Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-12 
2.5.3 Bit Pressure Drop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-14 
2.5.4 Equivalent Circulating Density . . . . . . . . . . . . . . . . . . . . . . .  2-16 

iii 



Table of Contents (Cont'd.) 

2.6 SURGE AND SWAB PRESSURES . . . . . . . . . . . . . . . . . . . . . . . .  2-16 

2.7 BUCKLING THEORY . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-17 

2.7.1 Sinusoidal Buckling . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-17 
2.7.2 Helical Buckling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-18 
2.7.3 Spring Theory Buckling . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-20 
2.7.4 Which One Do I Use? . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-21 

2.8 HELICAL FRICTIONAL FORCE AND LOCKUP . . . . . . . . . . . . . .  2-21 

2.9 TRIAXIAL. BIAXIAL. AND API STRESS ANALYSIS . . . . . . . . . . .  2-22 

2.9.1 Triaxial Equation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-23 
2.9.2 Biaxial Equation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-25 
2.9.3 API Equation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-25 

3 . TORTUOSITY . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-1 

3.1 MODELDESCRIPTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-1 

4 . PROGRAM INSTALLATION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4.1 

4.1 BEFORE INSTALLING . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1 

4.1.1 Check the Hardware and System Requirements . . . . . . . . . . . . . .  4-1 
4.1.2 Check the Program Disk . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1 
4.1.3 Backup Disk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2 

4.2 INSTALLING CSTRESSl . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2 

4.3 STARTING CSTRESSl . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-3 

4.3.1 Start CSTRESSl from Group Window . . . . . . . . . . . . . . . . . . .  4-3 
4.3.2 Use Command-Line Option from Windows . . . . . . . . . . . . . . . .  4-3 

4.4 ALTERNATIVESETUP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-3 

5 . BASIC OPERATION OF  MICROSOFT WINDOWS . . . . . . . . . . . . . . . .  5.1 
5.1 THETITLEB AR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-1 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5.2 THECONTROLBOXES 5-1 

5.3 MINIMIZE AND MAXIMIZE BOXES . . . . . . . . . . . . . . . . . . . . . .  5-1 

5.4 TEXTBOXES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-2 

5.5 CHECKBOXES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-2 

5.6 OPTION BUTTONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-3 

5.7 COMMAND BUTTONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-3 



Table of Contents (Cont'd.) 

Page 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5.8 LISTBOXES 5-3 

5.9 DROP-DOWN LIST BOXES . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5 4  

5.10 SCROLLBARS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5 4  

5.11 GRID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5 4  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6.1 OVERVIEW 6-1 

6.2 GE'ITING STARTED . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6.2 

. . . . . . . . . . . . . .  6.3 PULL-DOWN MENUS IN THE INPUT WINDOW 6-3 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6.4 THE INPUT WINDOW 6-8 

6.4.1 Page 1: Criteria Window . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-8 
6.4.2 Page 2: Well Data Input (WDI) . . . . . . . . . . . . . . . . . . . . . . .  6-9 
6.4.3 Page 3: Survey Data Input (SDI) . . . . . . . . . . . . . . . . . . . . . .  6-9 
6.4.4 Page 4: Tubular Data Input (TDI) . . . . . . . . . . . . . . . . . . . .  6-10 

. . . . . . . . . . . . . . . . . . .  6.4.5 Page 5: Parameter Data Input (PDI) 6-13 

6.5 SAVE INDIVIDUAL FILES . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-14 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6.6 RUN 6-15 

6.7 OUTPUT WINDOW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-15 

6.7.1 Print Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-16 
6.7.2 Manipulating the Output Graph . . . . . . . . . . . . . . . . . . . . . .  6-17 
6.7.3 Select Output Graph Curves . . . . . . . . . . . . . . . . . . . . . . . .  6-19 
6.7.4 Bi-Axial Graph . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-20 
6.7.5 Pump Equipment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-21 
6.7.6 Exit Output Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-21 

6.8 USING TORTUOSITY . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-22 

6.9 CSTRESS HELP AND DIALOG BOXES . . . . . . . . . . . . . . . . . . . .  6-23 

6.9.1 Help - Assistance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-23 
6.9.2 Help - About . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-24 
6.9.3 Open Project and Data File . . . . . . . . . . . . . . . . . . . . . . . . .  6-24 
6.9.4 Save Project - Data File . . . . . . . . . . . . . . . . . . . . . . . . . .  6-26 
6.9.5 Color . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-26 

6.10 CSTRESS ERROR HANDLING . . . . . . . . . . . . . . . . . . . . . . . . . .  6-27 

6.11 QUICK START . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-27 

7 . REFERENCES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7-1 

8 . BUG REPORT OR ENHANCEMENT SUGGESTION FORM . . . . . . . . . .  8-1 





1. Introduction 

The coiled-tubing stress analysis (coiled-tubing stress/drag/hydrauliclbuckling) windows applications 

program (CSTFSSl) has been developed by Maurer Engineering Inc. as part of the DEA-67 project 

to "Develop and Evaluate Slim-Hole and Coiled-Tubing Technology." This program, coded in Visual 

Basic 1.0, is written for use with IBM or IBM compatible computers and must run with Microsoft 

Windows 3.0 or later version. 

1.1 MODEL DESCRIPTION 

CSTFSSl  is an integrated computer program of drag force, hydraulics, buckling, and triaxial 

stress analysis. It is a major rewrite of the coiled-tubing model, not just an update. The features of 

CSTFSSl  are listed below. 

1.1.1 General Fea ture  

1. MS Windows applications. 

2. Five operations: pick up (logging), slack off (logging), pick up (drilling - tripping), 
slack off (drilling - tripping), and drill. 

3. Supports both color and monochrome monitors. 

4. Supports English and metric unit systems. 

5. Handles up to fifteen tube segments and twenty well intervals. 

6. Coiled-tubing and casing data can be imported from the built-in data base file directly. 

7. Enables the user to modify the data base within the program. 

8. Allows input of pore and fracture pressures for different well interval. 

9. Results, data and graphs, can be output to screen, printer, and disk file. 

10. Selectable curves on output graphic presentation. 

1.1.2 Drag Force. Axial Load. and Triaxial Stress 

1. Computes axial drag on coiled-tubing during pick up, slack off, and drilling. 

2. Computes axial load and stress on coiled-tubing during pick up, slack off, and drilling. 
The axial load and stress is based on tubing pressure, annulus pressure, pipe weight, 
and frictional force. 

3. Bending stress (based on dogleg or helical buckling curvature) can be included in the 
calculation. 

4. Extra frictional force caused by helical buckling can be included in the calculation. 

5 .  Calculates triaxial stress and has both graphics and text output. 

6. Calculates allowable working stress and pressure for biaxial and API stress criteria 
with graphic output. 

7. Calculates maximum cable load. 



1.1.3 Hydraulics 

1. Calculates internal and external pressures on the tubing at various locations during 
tripping and drilling. 

2. Calculates bottom-hole pressure and ECD during tripping. 

3. Calculates ECD corresponding to the total pressure along the wellbore. 

4. Plots pore and fracture pressures along the wellbore (optional). 

5. Calculates pressure loss of the coiled tubing remaining on the reel. 

6. Calculates the required pump horsepower. 

1.1.4 Buckling 

1. For compressive loads, the onset of 1) sinusoidal buckling, 2) helical buckling, and 3) 
Limiting yield stress are indicated. 

2. Two sinusoidal buckling criteria can be evaluated: 1) Exxon's equation, and 2) Texas 
A&M University's equation. 

3. Two helical buckling criteria can be evaluated: 1) Rice University's equation, and 2) 
Texas A&M University's equation. 

1.1.5 Tortuositv 

1. Survey data can be "tortured" (add tortuosity along the trajectory of wellpath). 

2. Allows insertion of equally spaced stations to survey data. 

3. Different tortuosity amplitude and cycle lengths can be applied up to five wellpath 
intervals. 

1.2 COPYRIGHT 

Participants in DEA-67 can provide data output from this copyrighted program to third parties and 

can duplicate the program and manual for their in-house use, but will not give copies of the program or 

manual to third parties. 

1.3 DISCLAIMER 

No warranty or representation is expressed or implied, with respect to these programs or 

documentation, including their quality, performance, merchantability, or fitness for a particular purpose. 



2. Theory and Equations 

2.1 AXZAL DRAG 

The drag model is based on a simple mathematical model, developed by Exxon Production 

Research (Johancsik et al., 1984). The model assumes the loads on the tubing result solely from effects 

of gravity and frictional drag resulting from contact of the tubing with the wall of the hole. These 

frictional forces are the products of the normal force acting between the tubing and the wellbore and the 

coefficient of friction (friction factor). Two contributions to the normal force are considered for this 

model: 1) the effects of gravity on the tubing and 2) the effects of tension and compression acting 

through curvatures in the wellbore. Although bending may make minor contributions to normal force, 

its effect is neglected in this model. 

The model considers the tubing to be made up of short segments joined by connections which 

transmit tension, compression and torsion, but not bending moment. The basic equations of friction are 

applied to each segment with the calculations starting at the bottom of the tubing and proceeding upward 

to the surface. Each short element thus contributes small increments of axial drag and weight. These 

forces are summed to produce the total loads on the tubing. For this version of CSTRESS, torsion is 

not taken into consideration. 

2.1.1 Introduction to the Variables 

Figure 2-1 is a simple free-body diagram of a single element of the tubing. 

Figure 2-1. Free-Body Diagram of a Single Element 



f = Friction Factor 

F = Axial Friction Force 

M = Torque = 0 for Coiled Tubing 

N = Normal Force 

T = Tension 

R = Effective Radius of Element 

WTM 
= Buoyancy Weight of Coiled Tubing or Weight in Mud 

WCM = Buoyancy Weight of Loose Cable in Coiled Tubing 

B = Inclination Angle 

B = Average Inclination Angle 

4 = Azimuth Angle 
A = Incremental Values 

2.1.2 Derivation of the Eauations 

When a loose cable is suspended inside the coiled tubing, the weight of the cable is 

suspended by the reel while the weight of the tubing and frictional drag are suspended by the injector 

head (hook load). Therefore, the weight of the cable effects the weight term in the normal force equation 

(Eq. 2-l), but does not effect the weight term in the tension increment equation (Eq. 2-2). 

In analyzing each segment, the first requirement is to calculate the magnitude of the 

normal force, N, as follows: 

The tension increment is then calculated as follows: 

In this equation, the plus sign is used for upward motion (meaning axial drag adds to the eeffect 

of gravity), and the minus for downward motion (meaning axial drag subtracts from the effect of gravity). 

2.1.3 Consideration of Multi-Element Cases 

As the calculation procedure takes place, T + AT becomes T for the element above the 

present calculation point and AT contributes to the overall sum. When completed, the analysis yields 

tensile loads as functions of depth along the string. 



2.2 APPLYING THE DRAG MODEL TO A STRING OF COILED TUBING 

To apply the mathematical model in the stepwise fashion as shown earlier, it is necessary to 

specify the following information for each element: 

1. Physical size a d  weight 
2. Spatial orientation 
3. Nature of motion 
4. Tensile load at the bottom of the element 
5. Friction factor 

The following paragraphs discuss each of these and relate them to tubing design or operational 

parameters, whichever is applicable. 

2.2.1 Phvsical Size and Weieht 

One aspect of physical size is the length of the element. When a stepwise solution is 

applied, this will be the size of each "step" as the solution process marches up the tubing. The outside 

and inside diameters of the elements are needed to calculate stress and buckling criteria. These are 

obtained from a physical description of the tubing. The weight of the element, adjusted for the effects 

of buoyancy, is part of the tensile force balance. 

2.2.2 Soatial Orientation 

Spatial orientation refers to the values for inclination and azimuth angle at both ends of 

the element. These can be obtained from wellbore survey information. 

2.2.3 Nature of Motion 

The nature of the motion is necessary to determine what effect the drag force has. If the 

string is moving up, the drag force adds to the weight component of tension. When downward motion 

is present, the drag force subtracts from the weight component. 

In terms of actual operations, upward motion occurs when raising the string of tubing 

(i.e., picking up or coming out of the hole). Downward motion corresponds to lowering the string (i.e., 

slacking off, drilling, or going in the hole). 

2.2.4 Loads at  the Bottom of Each Element 

The tensile drag at the lower end of the element must be known prior to calculation of 

the element. Remember, the model takes the increment of tension due to drag and weight and adds this 

to the tension value found at the lower end of the element. However, this information does not have to 

be supplied for every element because the model uses the value calculated for the upper end of the 

current element as the initial value for the lower end of the next element. Thus, the boundary conditions 

of the tensile drag at the bottom of the string are all that must be provided. 



The values used for boundary conditions at the bottom of the coiled-tubing string will 

depend upon the operation being simulated. When the string is going into the hole, (slack off or drill), 

the bottom of the string is in compression. When the string is coming out of the hole, the bottom of the 

string is in tension. The following are the factors that affect bottom boundary conditions for each 

operation being simulated. 

1. Pick up (logging): Consists of logging tool weight and bottom tool drag. 
2. Slack off (logging): Consists of logging tool weight and bottom tool drag. 
3. Pick up (drilling, tripping): Consists of bottom tool drag. 
4. Slack off (drilling, tripping): Consists of bottom tool drag. 
5. Drill: Consists of bottom tool drag and weightan-bit. 

2.2.5 Loads a t  the Tor, of the Coiled Tubing 

Stuffing box drag is a load applied both during pick up and slack off. It simulates the 

frictional drag in the seal of a stuffing box or lubricator. It has no effect on the tension loading of the 

tubing below the stuffing box. It increases tension in the tubing above the stuffing box during pick up 

operations and decreases tension when slacking off. 

Coiled-tubing reels keep a constant back tension on coiled-tubing which is called pick-up 

reel back tension and slack-off reel back tension. This back tension reduces the load read on the 

transducers at the injection head. The back tension is always in the same direction, whereas friction in 

the stuffing box gland changes direction from pick up to slack off. 

2.2.6 Friction Factor 

The friction factor is a very important number because it is the one parameter that char- 

acterizes the surface-to-surface interaction central to the mathematical model. A great amount of work 

has gone into obtaining and verifying values of friction factor for predictive work. A few comments at 

this point will facilitate a better understanding of the application of friction factors to wiled tubing. The 

exact value of the friction factor applicable to a situation is a function of many things, including drilling 

fluid type and composition, formation type (in open hole), casing material and condition (in cased hole), 

and tubing material and condition (e.g., roughness). At a single point in time, the mud type and 

composition in the well are constant but significant changes may be taking place in portions of both cased 

and open hole. Thus, in certain cases, it may be necessary to use two friction factors, one for the 

tubinglcasing interaction and one for the tubinglforrnation interaction. 

2.2.7 Cable Load 

The maximum tensile cable load, Tc, at the top of the cable equals: 

where: 

T~ = Maximum Cable Tensile Load 

TVDCable = Maximum TVD of Cable 

W c = Cable Buoyed Weight 

This tensile load is supported by the reel and not by the injector head. 



2.3 AXIAL STRESS AND LOAD 

The torque and drag model mentioned previously considers only the effects of mechanical force 

or drag force. It does not consider compressive loads imposed on the tubing string as a result of 

hydrostatic pressure. The model gives correct results for torque and drag and buckling calculations but 

not for mechanical strength failures and burst ard coUapse b l e s .  b f o r e ,  load contribution due to 

hydraulic pressure must be considered. 

2.3.1 Load at Bottom 

A hydrostatic or buoyant compressive force acts on the bottom of the tube. This force 

is caused by the hydrostatic pressure in the liquid at the bottom of the hole. The magnitude of this force 

is given by 

'a- F~~ = -, (pOb x oo2 - pib x lo2) 

Fhb = Compressive load acting on the end of the tubing string 

Pob = Bottom tube annual pressure 

Pib = Bottom tube inside pressure 
OD = Bottom tube outside diameter 

ID = Bottom tube inside diameter 

When hydraulic force combines with logging tool weight, BHA drag, or weight-on-bit 

it becomes bottom-boundary load. 

2.3.2 Axial Load 

To calculate axial load, you would modify Eqs. 2-2 to 2-4. Since hydrostatic pressure 

is considered in the bottom-boundary load, the buoyancy force should not affect pipe weight contribution 

in the axial direction. For normal force (lateral side load), buoyancy must be considered. In analyzing 

each segment, Eqs. 2-1 to 2-4 become: 

It is the same as Eq. 2-1, the tension increment is calculated as follows: 



A Ta = Axial load (tension) increment 

WTa = Tubing weight in air 
N = Normal force 

f = Friction factor 

F = Axial friction force 

2.3.3 Hook Load 

Hook load measured at the injector head equals: 

Hook Load (Pick up) = TP + FD - FR 

Hook Load (Slack off) = TS - FD - FR 

Hook Load (Drill) = T D - F D - F R  

where: 

Tp = Pick-up Tensile Tubing Load below Stuffing Box 

TS = Slack-off Tensile Tubing Load below Stuffing Box 

TD = Drill Tensile Tubing Load below Stuffing Box 

FD = Stuffing Box Drag 

FR = Reel Back Tension 

This hook load is applied to the tubing by the injector head. The hook load does not 

include the force to support the cable since the cable is supported by the reel and not by the injector head. 

2.3.4 Axial Stress 

Axial stress without bending stress which is exerted by wellbore dogleg or helical 

buckling is: 

ua = Ta / cross section area or (2-1 1) 

where: 

a, = Axial stress 

T, = Axial load 



2.3.5 Axial Load and Axial D r a  
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Figure 2-2. Compare Axial Load and Axial Drag 
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Shown in Figure 2-2 is a steel tube in water. At the bottom of the tube, the inside and 

outside pressures are equal. Axial load curve and axial drag curve that intersect at water level can easily 

be found. For axial drag calculation, tube buoyancy weight (weight in water) is used. For calculating 

axial load, weight in air and hydraulic pressure at the bottom of the tube are used. 

/ 
/ 
/ 

/ 

/ 

: 

2.4 BENDING STRESS 

Bending stress can be exerted by either wellbore dogleg or helical buckling. The bending stress 

from dogleg is shown below: 

/ 
/ 

/ 

a,, = (T E . DL OD) 1432000 (2- 13) 

/+ 

where: 

UDL = Bending stress exerted by dogleg (psi) 

E = Elastic modulus (psi) 

DL = Dogleg ("1100 ft) 

OD = Tube outside diameter (in.) 

If the tubing is in helical bending, the path of tubing is not only following the wellbore, but is 

also following the spiral shape (Lubinski et al., "Helical Buckling of Tubing Sealed in Packer" Journal 

of Petroleum Technology, June, 1992). The pitch of helical buckling can be estimated due to axial drag. 

After the pitch is obtained, the curvature of the tube with helical buckling can be found. 

r = Clearance 

P = Pitch of helical buckling 

k = Curvature of the tube with helical buckling 

ahel = Bending stress due to helical buckling 



E = Elastic modulus 

I = Moment of inertia 

HID = Hole diameter 

T = Axial drag 

OD = Tube outside diameter 

r = 
HID - OD 

2 

uhd is the helically buckled tube's bending stress, so in the helical buckling section of coiled 
tubing, the bending stress will be uhel (Eq. 2-17) rather than (Eq. 2-13). 

2.5 HYDRAULICS ANALYSIS 

The models most commonly used in the drilling industry to describe fluid behavior are the 

Bingham plastic and power-law models. They can be used to calculate frictional pressure drop, swab 

and surge pressures, etc. The hydraulic calculation in CSTRESSl is based on equations derived in 

Applied Drilling Engineering (Bourgoyne et al., 1986) and API SPEC 10. The more sophisticated 

Herschel-Buckley model has not been included in this program because of lack of experimental data, but 

it will be considered in the future version. 

2.5.1 Bineham Plastic Model 

The Bingham plastic model is defined by Eq. 2-18 and is illustrated in Figure 2-3. 

7 = t ( p j . + T Y  ; 7 > T Y  



where: 

ry = Yield stress 
p,, = Fluid viscosity 
7 = Shear stress 

j. = Shear rate ;y 
.r 

1 SHEAR RATE , f 

Figure 2-3. Shear Stress Vs. Shear Rate for a Bingham Plastic Fluid 
(Bourgoyne et al., 1986) 

As shown in Figure 2-3, a threshold shear stress known as the yield point (7y) must be 

exceeded before mud movement is initiated. 

The mud properties p,, and ry are calculated from 3 W  and 6O&rpm readings of the 

viscometer as follows: 

p,, = ~ a o o  -9300 
7y = 9300 - p,, 

where: 

Om, 9300 = shear readings at 600 and 300 rpm, respectively. 

Calculation of frictional pressure drop for a pipe or annulus requires knowledge of the 

mud flow regime (laminar or turbulent). 

1. Mean Velocity 

The mean velocities of fluid are calculated by Eq. 2-20 and 2-21. 

For pipe flow: 
- 
v = Q 

2.448d * 



For annular flow: 
- 
v = Q 

Where: 
- 
v = Mean velocity, Wsec 

Q = Flow rate, gallmin 

d = Pipe diameter, in. 

d2 = Casing or hole ID, in. 

dl = Drill string OD, in. 

2. Hedstrom Number 

The Hedstrom number, N,, is a dimensionless parameter used for fluid flow regime 

prediction. 

For pipe flow: 

3 7 , 1 0 0 ~  7, d2 
N, = 

2 
cc, 

For annular flow: 

Where: 
p = Mud weight, lblgal 

3. Critical Reynolds Number 

The critical Reynolds number marks the transition from laminar flow to turbulent 

flow. The correlation between Hedstrom number and critical Reynolds number is presented in 

Figure 2 4 .  The data in Figure 2 4  have been digitized in the program for easy access. 



HEDSTROM NUMBER, N,, 

Figure 2 4 .  Critical Reynolds Numbers for Bingham Plastic Fluids 
(Bourgoyne et al., 1986) 

4. Reynolds Number 

Reynolds number, NRer is another common dimensionless fluid flow parameter. 

For pipe flow: 

For annular flow: 

757 p V (d2 - dl) 
NRe = 

cc, 
5. Frictional Pressure Drop Calculation 

For pipe flow, the frictional pressure drop is given by: 

(1) Laminar flow (NRe < Critical NRe ) 

(2) Turbulent flow (NRe r Critical NRe ) 

where f is the friction factor given by 



= 4 log ( ~ ~ 8 )  - 0.395 

For annular flow, the frictional pressure drop is: 

(1) Laminar flow (NRe < Critical NRe ) 

(2) Turbulent flow (NRe 2 Critical NRe ) 

where f is determined using Eq. 2-28. 

2.5.2 Power-Law Model 

The power-law model is defined by Eq. 2-31 and illustrated in Figure 2-5. 

T = KT" (2-3 1) 

where: 

K = Consistency index, equivalent centipoise (see Bourgoyne et al., 1986) 
n = Flow behavior index, dimensionless 

Figure 2-5. Shear Stress Vs. Shear Rate for a Power-Law Fluid (Bourgoyne et al., 1986) 

The fluid properties n and K are calculated as follows: 

2-12 



n = 3.32 log- 
f3300 

The critical Reynolds number must be determined before the frictional pressure drop 

can be calculated. 

1. Mean Velocity 

For pipe flow: 

For annular flow: 

2. Critical Reynolds Number 

The critical Reynolds number can be read from Figure 2 4  for a given flow 

behavior index n. 

5 . , 
5 , , , ,  , , , .  8 

, , : ' :  I , . , . .  , \ . I l l i , .  I 8 . / I  

.. - ,  

2 

acux 
m 2x30 ;mx3 1WL-M lmoa 

REYNOLDS N U Y B i 7 .  N ~ ,  

Figure 2 4 .  Friction Factors for Power-Law Fluid Model (Bourgoyne et al., 1986) 

The data in Figure 2 4  can be approximated by the following (LeiEio et al., 1990): 

Critical NRe = 4200 for n < 0.2 

Critical NRe = 5%0 - 8800 n for 0.2 < n < 0.45 (2-36) 

Critical NRe = 2000 for n > 0.45 



3. Reynolds Number 

For pipe flow: 

For annular flow: 

4. Frictional Pressure Drop Calculation 

For pipe flow: 

(1) Laminar flow: (NRe < Critical NRJ 

(2) Turbulent flow (NRe 2 Critical NRJ 

where the frictional factor f is given by: 

For annular flow: 

(1) Laminar flow: (NRe < Critical NRe) 

dpf - - KV" 
144,000 (d2 -dl)('+") 

(2) Turbulent flow (NRe 2 Critical NRJ 

- - - 
dL 21.1 (d2-dl) 

where f is calculated using Eq. 241. 

2.5.3 Bit Pressure D r o ~  

There are three assumptions made to calculate bit pressure drop: 

1. The change in pressure due to change in elevation is negligible. 



2. Upstream velocity is negligible compared to nozzle velocity. 

3. Frictional pressure drop across the nozzle is negligible. 

Nozzle velocity equals 

where: 
V, = Nozzle velocity, Wsec 

Q = Flow rate, gallmin 

AT = Total nozzle area, in. 2 

and bit pressure drop equals 

where: 

Cd = discharge coefficient factor (recommended value = 0.95) 
(Bourgoyne et al., 1986) 

The hydraulic horsepower (HHP) and the impact force (Fi) at the bit are 

A P b Q  
HHP = - 

1714 

The total pressure drop in the system equals: 

P&=CPp + c P, + APb 

Where: 

Pp = Summation of pressure losses inside the pipe 

Pa = Summation of pressure losses in the annulus 

Therefore, the pump horsepower (PHP) is 

Q PHP = Pbd - 
1714 

where: 

A PBUd = surface equipment pressure loss, psi 

Q = flow rate, gallmin 



2.5.4 EauivaIent Circulatine Density 

Of particular importance is the equivalent circulating density (ECD) at a certain depth. The 

ECD is the density of fluid that will produce the same hydrostatic pressure as the circulating pressure 

at that point (bottom of the hole) i.e., 

ECD = 
Po 

0.052 x TVD (lblgal) 

where: 

Po = Pressure at the point, psi 

TVD = True vertical depth at the point, ft 

2.6 SURGE AND SWAB PRESSURES 

Equations 2-26 through 2-30 and 2-39 through 2-43 have been presented for frictional pressure 

drop calculation, the first set for a Bingham plastic fluid and the second for a power-law fluid. These 

models can also be applied to determine surge and swab pressures if the running speed of the drill pipe 

is known. Surge pressure is the pressure increase caused by lowering pipe into the well. Pressure 

decrease, resulting from withdrawing pipe from the well, is called swab pressure. 

For a closed pipe, the estimated annular velocity is (Moore, 1974): 

where: 

vp = Pipe running speed, ftlmin 

v = Average annular fluid velocity, ftlmin 

K = Clinging constant (recommended value = 0.45). 

Moore suggested using maximum fluid velocity to take into account the acceleration and 

deceleration of the pipe. In general, the maximum fluid velocity equals: 

V, = 1 . 5 ~  (2-52) 

Surge and swab pressures are calculated by substituting maximum fluid velocity for mean velocity 

in the previously presented frictional pressure drop equations. 

Of particular importance is the equivalent circulating density (ECD) due to surge and swab 

pressures. The calculation of ECD can be performed using Eq. 2-50. 



2.7 BUCKLING THEORY 

The compressive loads required to initiate the onset of sinusoidal, helical, and spring theory 

buckling are indicated on the graphic output of the slack-off plots. The significance of these three stages 

of buckling is as follows: 

2.7.1 Sinusoidal Buckling 

As compressive force is increased on a length of tubing lying along the bottom of an 

inclined hole, a point is reached where the tubing will assume a sinusoidal configuration along the bottom 

of the hole (Figure 2-7. The critical force required to achieve this is calculated using either the Exxon 

formula presented in Eq. 2-53 (Dawson and Paslay, Joumal Petroleum Technology, October 1984, 1734 

- 1738) or the Texas A&M University formula presented in Eqs. 2-55 - 2-57 (Wu and Juvkam-Wold, 

ASME Paper 93-PET-7. 

where: 
FCsi, = Critical axial load to begin sinusoidal buckling, lbf 

E = Elastic modulus, psi 
I = Moment of inertia of tubing cross section, inches4 

r = Radial clearance between tubing and borehole, inches 

8 = Inclination of hole, degrees 

6' = Average inclination of hole section, degree 

WmUd = Unit pipe weight in mud, lbflin. 
R = Radius of the curvature, in. 

In Exxon's equation, if the inclination angle is zero, then the sinusoidal buckling critical 

load is zero. In the program CSTRESS, if the inclination is less than 3O, the program uses 3' instead 

of the inclination (Eq. 2-54). 

Exxon 

Exxon 

For the vertical, slant, and curved sections, A&M uses three equations for each situation 

to find the critical buckling load. 



[E I . wYd sin (6 )  
F,,;, = 2 . I lr_ 

Figure 2-7. Sinusoidal Buckling 

2.7.2 Helical Buckling 

( for vertical) (2-55) 

(for slant) 
(2-56) 

(2-57) 
(for curved) 

If the axial compressive load is increased beyond the point where sinusoidal buckling 

occurs, helical buckling will eventually result. In helical buckling, the tubing forms a helix along the 

wall of the hole, the pitch of the helix decreasing as compressive load increases (Figure 2-8). 



Figure 2-8. Helical Buckling 

The critical force required to achieve helical buckling is calculated using either the Rice 

University formula presented in Eq. 2-59 (Chen, Lin, and Cheatham, 1989, "An Analysis of Tubing and 

Casing Buckling in Horizontal Wells," OTC 6037) or the Texas A&M University formula presented in 

Eqs. 2-61 - 2-63 (Wu and Juvkam-Wold, ASME Paper 93-PET-7). 

Rice 

Rice 

E - I WmUd .sin(3) 
F,,, = 2 .Ji- (for 0 < =  3") ( 2 a )  

r 

( for vertical) (2-61) 

E I Wmud sin@) 
Fche, = 2 ( 2  ' fi - 1 )  I lC ( for slant) (2-62) 

r 



- [ I  + r . R' .wmUd . sin 01 'I2] 
4 . E . I  

From Exxon's and Rice's formulas (Eqs. 2-53 and 2-59), helical buckling begins when the 

axial compressive force is 1.414 (6) times the value of sinusoidal critical buckling load. 

2.7.3 S~r ing  Theorv Buckling 

If compressive axial load is increased beyond that required to initiate helical buckling, the 

pitch of the helix decreases until a point is reached where the shear stress loading of the tubing will equal 

its minimum yield shear stress (Figure 2-9). This is calculated using Equation 2-64 which is based on 

the theory of helical springs under compression. (See A.M. Wahl, "Mechanical Springs, " 2nd edition, 

McGraw Hill Book Company, New York, 1963.) 

where: 

Fwr = C r i t i c a l f m Q m p i r d t o r a i S e ~ ~ t o ~ ~ p e a d h , I b s  

d = Tubing diameter, inches 

D = Hole diameter, inches 

t = Minimum yield in shear, psi. This is equal to half of the tensile yield. 

( a )  Axially loadcd hc l i a l  spring; (b) Ga-body diagram showing that ~ h c  wirc u 

subjcc~cd lo A dircci s h u r  And A torsional s h u r .  

Figure 2-9. Axially-Loaded Helical Spring 



2.7.4 Which One Do I Use? 

As indicated above, the smallest critical force is FcBin, the critical wmpressive force 

required to initiate sinusoidal buckling. Next largest is Fchel, the critical wmpressive force to change 

from sinusoidal to helical buckling. The largest of the three critical forces is Fwr, the axial force 

required to increase the maximum shear in the wiled tubing to equal the minimum yield in shear of the 

tubing. 

Newman, Corrigan, and Cheatham, in SPE 19229, indicate that wiled tubing can be pushed 

into a hole safely using wmpressive loads wnsiderably in excess of the sinusoidal buckling threshold 

calculated by Equations 2-53 - 2-57. In the field cases they report, wmpressive forces greater than the 

sinusoidal critical force, F&,,, have been used to push wiled tubing into inclined holes. Because of well 

geometry, they were unable to test wmpressive forces greater than the helical buckling critical force, 

Fchel. It is theii belief that compressive forces larger than the critical helical buckling force, F chcl, can safely 

be used to push wiled tubing into deviated holes, and they are proposing expimental verification of this 

assumption. 

Logging operations by Canadian Fracmaster and Esso Resources Canada in British 

Columbia have shown that wiled tubing can be safely subjected to buckling forces midway between the 

helical and spring limits. Recent experience of at least one of the service companies indicates that the 

critical load calculated from helical spring theory, Fcpr, is a reasonable indicator of the near upper limit 

of safe wmpressive forces to use to insert wiled tubing into deviated holes. This force is wnsiderably 

larger than the force required to initiate helical buckling. It has been reported that when Fcpr was 

"exceeded in moderation," no damage to the tubing was observed. 

These criteria (FcBin, Fchel, and Fcpr) should be used with caution and as guides rather than 

as absolute indicators. Judgment based on experience, though sometimes expensive to acquire, is of great 

value when dealing with such concepts as buckling and all its implications. Buckling does not necessarily 

imply failure, but indicates the onset of a wndition which may precipitate failure. 

When more accurate or significant critical buckling load criteria are developed, they will 

be incorporated into CSTRESS either in addition to, or as replacements for the three criteria presently 

employed. 

2.8 HELICAL FRICTIONAL FORCE AND LOCKUP 

Once coiled tubing becomes helically buckled, the tube body will exert extra normal force against 

the wellbore so helical buckling causes additional frictional force called "helical frictional force." The 

helical frictional force equation is evaluated in "Frictional Drag Analysis for Helical Buckled Pipes in 

Extended Reach and Horizontal Wells" ( J i i  Wu and Haas C. Juvlam-Wold, 93-PET-8). 



where: 
- 

Fhel - Helical Frictional Force 
E - - Elastic Modulus 

I - - Moment of Initial 

T - - Axial Compressional Force 

r - - Clearance 

f - - Friction Factor 

a l  = Segment Length 

Equation 2-65 is based on the following assumptions: 

1. Axial compressional forces on both ends of the segment are equal which implies that segment 
length is relatively short. 

2. Originally, this equation was derivated for weightless pipe in a straight wellbore. 

When axial compressional force is increased, the equation shows that helical frictional force is 

increased as the square of compressional force. This helical frictional force against the tube moving into 

the well causes extra axial compressional force for the next (upper) tube segment. If the helical frictional 

force is large enough, the compressional force is balanced by the helical frictional force no matter how 

much force is applied at the surface. In this situation, the helical buckling section locks and the tubing 

string below the helical buckling section cannot move down to the hole. 

2.9 TRIAXIAL, BIAXIAL, AND API STRESS ANALYSIS 

An element of material subjected to stress ox, q, and oz in three perpendicular directions is said 

to be in a state of triaxial stress. A coiled-tubing string subjected to axial load and pressure (external 

andlor internal) is in a state of triaxial stress (Figure 2-10). 

Fa Axla! Load 

,o --ternol 
Pressure 

Figure 2-10. Triaxial Stress State 

Do Pipe OD 

U Fa Axial Load 



2.9.1 Triaxial Eauation 

The generally accepted relationship for the effect of axial stress on collapse or burst is 

based on the distortion energy theory. A closed triaxial design procedure has been developed using Von 

Mise's and Lame's equations. This present model does not consider torsional effects. 

Let E = Elastic Modulus 

Do = Pipe OD 

Di = Pipe ID 

ro = Pipe Outside Radius 

ri = Pipe Inside Radius 

a, = Yield Stress 

a, = Axial Stress 

Pi = Internal Pressure (psi) 

Po = External Pressure (psi) 

The pipe thickness is 

t = 0.5.(Do - D;) 

The cross area of pipe wall is 

A = r *(D: - D')l4 (2-67) 

Axial stress contains axial force, bending stress, and helical frictional force. According 

to Lame's equation for a thick tube, the hoop stress ah and the radial stress a, exerted by internal and 

external pressures at the cylinder at radius equals r. 

and 

For most cases, the maximum equivalent stress is at the pipe inside surface. Therefore, 

the equation can simplified by letting r = ri and rewriting the equation in pressure and diameter terms 

so the above equations become 

a, = -Pi (2-70) 

and 



2 
let C = 

do and Eq. 2-12 becomes 
2 st .(do - t) 

Von Mises's equation is 

2 u$ = [(u, - ud2 + (q - ~ 3 ) ~  + (u3 - .I)2] (2-73) 

where ul, u2, and uj are three principal stresses, and uv is the equivalent stress according to the dree 

principal stresses. Because the stresses a,, ah, and ua are three principal stresses, they can be inserted 

into Von Mises's equation 

2 = [(ua - + (uh - + (u, - ua12] (2-74) 

so the equivalent stress a,, becomes 

uv = ( 112 ( u ~  - 4 )2 + (uh - ur )2 + (u, - ua )2 ) (2-75) 

Combine Eqs. 2-70 and 2-71 with Eq. 2-74 and rearrange the terms in the equation. 

In Eqs. 2-76 and 2-77, if uv is replaced with u, (yield stress), the solutions Po and Pi 

are the limited collapse and burst pressures. 

Mathematically, there are two solutions for Po from Eq. 2-76 (for positive and negative 

square roots), but in practicality only positive real number(s) represent the collapse pressure Po. There 

can be one, two, or no solution(s) for the collapse pressure design. When bending stress is considered, 

caused by wellbore dogleg or helical buckling, the ua in Eq. 2-76 is either: 

ua = Minimum Axial Stress (aami,) = Average Axial Stress - Bending Stress 
or 

ua = Maximum Axial Stress (aami,,) = Average Axial Stress + Bending Stress 

This results in the solution(s) for collapse pressure design with minimum and maximum 

bending stress effects. 



Note, when an is replaced by a,;, and a,, both an,;, and a,, can have the 

positive square root solution. If this happens, the smaller value of the two positive square root solutions 

is the upper boundary of wllapse design. In the same way, the larger value from the two negative 

square root solutions is the lower-pressure boundary of the collapse design. 

Operating Pressure - 

I positive square root solutions 

max. operatlng pressure 

negatlve square root 

min. operating pressure 
4 

Figure 2-11. Bending Stress Effects on Burst Pressure Design 

2.9.2 Biaxial Eauation 

To disregdrd the internal pressure on collapse pressure design, let Pi = 0 and Eq. 2-76 

is simplified. 

If an and av are replaced by a,;, (Eq. 2-78), an, (Eq. 2-79), and a, bield stress), 

Eq. 2-80 produces the wllapse design pressure for biaxial stress analysis. 

Let Po = 0 in Eq. 2-77 and it becomes 

The above equation is the burst design pressure for biaxial stress analysis. 

where 

2.9.3 API Eauation 

API Bulletin, 5C3, 1989, "Formulas and Calculations For Casing, Tubing, Drill Pipe 

and Line Pipe Properties" (see for details) lists all API standard equations for axial stress limits, burst 

pressure limits, and four collapse pressure range limits. 



Depending on the Dlt ratio (diameter over thickness) of pipe, the collapse-tension curves 

for biaxial and API methods are different. Equations 2-68 and 249 are called Lame equations, they are 

derived from the thick tube stress (small Dlt value). The API collapse pressure formula for the plastic 

zone is derived by satistical regression analysis from more than 2400 casing collapse tests. The API 

collapse pressure formula for transition zone is determined by the curve fitting. This formula is used 

to determine minimum collapse pressure between its tangency to the elastic collapse pressure curve and 

its intersection with the plastic collapse pressure curve. The choice of triaxial, biaxial, or API criteria 

is left to the user. 



3. Tortuosity 

3.1 MODEL DESCRIlTION 

When planning a well, the surveys generated From geometric considerations, i.e., kick-off p in t ,  

build rate, path shape, etc., are smooth curves, whereas actual wells contain doglegs and other 

irregularities that increase torque and drag. When these "smooth curves" are input into the torque and 

drag model, the model predicts torque and drag values that are lower than those in actual wells 

containing doglegs and other irregularities. 

In the past, when "smooth" curves were used, the friction factors were artificially increased 

(e.g., From 0.22 to 0.29) to correspond to the increased torque due to hole irregularities. This technique 

gives good approximations of the actual torque, but it has the limitation that it predicts zero torque and 

zero frictional drag in vertical portions of the well, regardless of the friction factor, because he  lateral loads 

are zero in these "smooth" vertical sections. 'Ihe CSTRESS program calculates only the drag force. 

A very simple and elegant way to handle this problem been developed by Exxon, and was reported 

to us by Dr. Rap Dawson. 

To add tortuosity to the wellpath, a sinusoidal variation, whose period length (or cycle length) is 

a l ,  is added to both inclination and azimuth angle. This is in the form 

Tortuosity = T Sin (2.rMDJ A I) 

where: 

T = Amplitude or tortuosity number in degrees 
MD = Measured depth (ft) 

A I  = Period length or cycle length for 2.r 

In addition, the inclination angle is modified so that it will not become less than zero, since 

negative inclination angles are not allowed. 

The amplitude or tortuosity number T of the sinusoidal variation is varied according to the hole 

conditions. Exxon has found that a tortuosity of T = 1 represents typical field conditions. 

If the untortured survey data are of equal space and the value of measured depth for each survey 
Al station is n x - where n is any integer, then after calculation the survey data will not be tortured. 
2 



n * a 1  This is verified in Eq. 3-1 where MD = , then tortuosity added to inclination and azimuth 
2 

for each survey will be: 

Tortuosity = T sin (2r *MDlal) 
nwal 1 

= T - sin ( 2 r . * -  
2 a l  

= T . sin (n r )  

= 0 

Total dogleg added to the original survey depends on the survey data, Amplitude T, and period 

length. The amplitude or tortuosity munber (9 is the maximum possible degree added to or subtracted 

from inclination and azimuth. 

It is recommended that AI be chosen to do at least five times the interval between survey stations. 



4. Program Installation 

4.1 BEFORE INSTALLING 

4.1.1 Check the Hardware and Svstem Reauirements 

CSTRESSl is written in Visual J3asice. It runs in either standard or enhanced mode of 

Microsoft Windows 3.1 or higher. The basic requirements are: 

Any IBM-compatible machine built on the 80386 processor or higher. 

Hard disk. 

Mouse. 
CGA, EGA, VGA, Hercules, or compatible display. 

MS-DOS version 3.1 or higher. 

Windows version 3.1 in standard or enhanced mode. 

An 80486 processor and VGA display is recommended. 

For assistance with the installation or use of CSTRESSl contact: 

Lee Chu or Gefei Liu 
Maurer Engineering Inc. 

2916 West T.C. Jester Bwlevard 
Houston, Texas 77018-7098 U.S. A. 

Telephone: (713) 683-8227 Fax: (713) 683-6418 
Telex: 216556 

4.1.2 Check the Promam Disk 

The program disk is a 3% inch, 1.44 MB disk containing twenty files. These twenty files 

are as follows: 

SETUPKIT.DL MDICHILD . VBX 
V B R U N ~ O O . D ~  CMDIALOG.VBX 
VER.DL- CSGDB.DB 
GSWDLLDLL CTDB.DB 
GSW.EXE CDRAG4.EXE 
SETUP.EXE TEST.CDR 
SETUP 1 .EXE TEST. WDI 
SETUP.LST TEST.SDI 
GRAPH.VBX TEST.CT4 
GRID.VBX TEST.CP4 



We recommend that all .VBX and .DLL files, that have lhe potential to be used by other 

DEA67 Windows applications, be installed in your Microsoft Windows\SYSTEM subdirectory. This 

applies to all the .VBXs and .DLLs included here. The CSTRESSl executable (CSTRESS1.EXE) file 

should be placed in its own directory (default "C:\CSTRESSI"). AU these procedures will be done by 

a simple setup command explained in Section 4.2. 

In order to run CSTRESSI, the user must install all the files into the appropriate directory 

on the hard disk. Please see Section 4.2 to setup CSTRESSI. 

It is recommended that the original diskette be kept as a backup, and that working diskettes 

be made from it. 

4.1.3 Backu~  Disk 

It is advisable to make several backup copies of the program disk and place each in a 

different storage location. This will minimize the probability of all disks developing operational problems 

at the same time. 

The user can use the COPY or DISKCOPY command in DOS, or the COPY DISKETTE 

on the disk menu in the File Manager in Windows. 

4.2 INSTALLING CSTRESSl 

The following procedure will install CSTRESSI Erom the floppy drive onto working subdirectories 

of the hard disk (i.e., copy Erom B: (or A:) drive onto C: drive subdirectory CSTRESSI and 

WINDOWS\SYSTEM). 

1. Start Windows by typing "WIN" CENTER > at the DOS prompt. 

2. Insert the program disk in drive B:\. 

3. In the Fie Marager of Windows, choose pun] timn the Fie] menu. Type B:ktup and pres M r .  

4. Follow the on-screen instructions. 

This is all the user needs to setup CSTRESSI . After setup, there will be a new Program Manager 

Group (DEA APPLICATION GROUP) which contains the C.T. icon for CSTRESSI as shown in 

Figure 4-1. 



Figure 4-1. DEA APPLICATION GROUP and "CSTRESSl" Icon 

4.3 STARTING CSTRESSl 

4.3.1 Start CSTRESSl from Grouv Window 

To run CSTRESSl from the GROUP Window, the user simply double-clicks the 

"CSTRESSI" icon, or when the icon is focused, press <ENTER>. 

4.3.2 U u s  m 

In the Program Manager, choose [Run] from the [File] menu. Then type 

C:\CSTRESSl\CSTRESSl.EXE < ENTER>. 

4.4 ALTERNATIVE SETUP 

If the SETUP procedure described before fails, follow these steps to install the program: 

1. Create a subdirectory on drive C: C:\CSTRESSl. 

2. Insert the source disk in drive B: (or A:). 

3. Type: CD\CSTRESSl <ENTER>. 

4. At prompt C:\CSTRESSl, type: 
Copy B:\CSTRESSl.EXE <ENTER > 
Copy B:\*.DB <ENTER> 
Copy B:\TEST.* CENTER > . 



5. Type: CD\WINDOWS CENTER > . 
6. At prompt C:\WINDOWS > , type: 

Copy B:\VBRUN 100.DL - VBRUN 100.DLL <ENTER > . 

7. Type: CD\WINDOWS\SYSTEM CENTER > . 

8. At prompt C:\WINDOWS\SYSTEM>, type: 
Copy B:\*.DLL <ENTER> 
Copy B:\*.VBX <ENTER>. 
Copy B:\GSW.EXE <ENTER> 

9. Type: CD.. <ENTER> then key in "WIN" CENTER > to start Widows 3.1 or later 
version. 

10. Click menu "File" under "PROGRAM MANAGER," select item [New . . . I  click on [PRO- 
GRAM GROUP] option, then [OK] button. 

11. Key in "DEA APPLICATION GROUP" after label "Description:," then key in "DEAMEI" 
after "Group File:," then click on [OK] button. A GROUP Window with the caption of 
"DEA APPLICATION GROUP" appears. 

12. Click on menu [File] again, Select [NEW . . . I  click on "PROGRAM ITEM" option, then, 
[OK] button. 

13. Key in "CSTRESSl" after label "Description," key in "C:\CSTRESSl\CSTRESSl.EXE 
after label "COMMAND LINE," then click on [OK] button. The CSTRESSl icon appears. 

14. Double-click the icon to start the program. 



5. Basic Operation of Microsoft Windows 

CSTRESSl runs in a Microsoft Windows environment. It is assumed that the user is familiar with 

Windows, and the user's computer is equipped with Windows 3.0 or later version. 

Some elements and terminology of Windows are reviewed here: 

r .Min~rnlzt Box 
, Conrrol Box , T ~ t l t  Bar  , .Mbxtrn~re Box - 
- or 

outpul 
81c M n d m  GrsphQpUon Help 

1 - 1' Rcrrors Box 

Cascade Shin+FS 
Dlc  ShnrrF4 
h a n g c  leone 

BLL 
Equlvalcnt Stcsa 
ttydraullc Prcssvrc 
W a l  Drag 
Surfam Load 
Boltom Hole Pressure 
pats Table 

B W a l  Graph 

Figure 5-1. Title Bar in Window 

5.1 THE TITLE BAR 

The title bar serves two functions: one is to display the name of the current window and the other 

is to indicate which window is active. The active window is the one whose title bar is in color. (On 
monochrome monitors, the difference is shown by the intensity of the title bar). The user can make a 

window active by clicking anywhere within its border. 

5.2 THE CONTROL BOXES 

At the left side of the title bar is the control box. It has two functions. First, it can display the 

CONTROL menu, which enables the user to control the window size using the keyboard. Second, 

double-clicking the control box will end the current program. 

During execution of CSTRESSl, the control boxes are not needed. The program will run 

according to its own flow chart. 

5.3 MINIMIZE AND M A m Z E  BOXES 

At the right side of the title bar are the MINIMIZE and MAXIMIZE boxes. The box with the up arrow 

is the MAXIMIZE box. The box with the down arrow is the MINIMIZE box. If a window has already been 

maximized, the MAXIMIZE box changes to a RESTORE box with both up and down arrows, as shown in 

Figure 5-1. 



Clicking on the M~VIMIZE box will reduce the window to the size of an icon. The window's 
name in the title bar appears below the icon. To restore a window from an icon, double-click 
on the icon. 

Clicking on the MAXIMIZE box will make the window take up the total working area. 

Clicking on the RESTORE box will make the window take up a portion of the total working area, 
which is determined by how the user manually sizes the window. 

5.4 TEXTBOXES 

TEXT boxes can display the information that the user enters. Sometimes there will be text already 

typed in for the user. The user can utilize arrow keys to edit the existing text. Figure 5-2 shows a 

typical text box. 

Figure 5-2. Text Box 

5.5 CHECK BOXES 

I 

A CHECK box indicates whether a particular condition is on or off. When it is on, an X appears. 

When it is off, the box is empty. Figure 5-3 shows a typical check box. 

- Calculation 0 ption: 

Include ALM buckling criteria 

[XI Include helical frictional force 

(XI Include bending stresses 

Company Name : 
Project Name : 
Well Name : 

Well Field : 
Well Ciiy I Sfate : 

Date : 

Comments : 

Figure 5-3. Check Box 
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O ~ O N  buttons are exclusive settings. Selecting an option immediately causes all other buttons 

in the group to be cleared. Figure 5 4  is a typical option box. 

' ~ ~ ~ ~ a ~  0 O i l  Field 

Figure 5 4 .  Option Buttons 

5.7 COMMAND BljlTONS 

A COMMAND button performs a task when the user chooses it, either by clicking the button or 

pressing a key. The most common command buttons are the OK and Cancel buttons found on almost 

every dialog box. In most cases, there is a button with a thick border-the default button which will be 

executed if you press CENTER > . Figure 5-5 shows a typical command button: 

-Edit pzL-1 p z i q  
Torluotity ... 

Figure 5-5. Command Buttons 

5.8 LIST BOXES 

A UST box gives the user a list of options or items from which to choose. If the UST box is too 
small to show all possible selections, a SCROLL box will appear on the right side of the box. The user 

makes a selection from a LIST box by clicking on it, or from the keyboard, highlighting the desired item 

with the arrow keys, and then pressing CENTER >. Figure 5-6 is a typical list box. 

1 D ;fine Color I*'] 
Figure 5-6. List Box 
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5.9 DROP-DOWN LIST BOXES 

A DROP-DOWN LIST box is indicated by a small arrow in a box to the right of the option. The 

current setting is shown to the left of the arrow. When the user clicks on the small arrow, it drops to 

list all selections. A typical dropdown list box is shown in Figure 5-7. 

Nazzle Si2er 

Figure 5-7. Drop-Down List Box 

5.10 SCROLL BARS 

SCROLL BARS are graphical tools for quickly navigating through a long line of items. There are 

two types of scroll bars: HORIZONTAL and VERTICAL SCROLL BARS. 

The small box inside the bar is called the SCROLL BOX. The two arrows on the ends of the scroll 

bar are scroll buttons (Figure 5-8). Clicking the scroll buttons or moving the SCROLL BOX will change 

the portion of the information you are viewing. 

Figure 5-8. Scroll Bar 

5.11 GRID 

GRID displays a series of rows and columns (Figure 5-9). In case of a long list of items or a large 

amount of information, scroll bars will attach to the grid providing easy navigation. 

Figure 5-9. Grid 
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In the INPUT Window, grids are used to let the user input data. Some columns of grid only allow 

number input. Typing of an alphabetical character is prohibited by the program. The user can edit an 

enuy by typing desired characters or pressing the <BACKSPACE> key to delete. In many grids, just 

like a spreadsheet, the user can insert and delete a row. 

On the other side, grids are for presentation only in the OUTPUT Window. They do not allow 

editing. 

The grid supports word-wrapped text presentation, resizeable columns and rows, etc. Even though 

the user can manually change the cell's column width or row height, we do not recommend this because 

all grids in CSTRESSl are carefully designed to fit the length of the appropriate data string. 





6. Running CSTRESSl 

CSTRESSl runs in Microsoft Windows environment. Windows' graphical user interface (GUI) 

and point-and-click environment gives the user the flexibility that is needed for today's software. 

6.1 OVERVIEW 

There are two major windows in CSTRESS 1: 
1. INPUT-CRITERIA Window 

2. OUTPUT Window 

Only one window can be shown on the screen at a time. The menu bar, control button, arrow 

keys, hot keys, etc., can be used to control the program's flow and the keyboard or mouse to input the 

data. Each major window contains several sub-pages or sub-windows to hold different groups of input 

and output information. 

The menu bar selection is not always available in certain sub-pages or sub-windows. This type 

- of design is to reduce the possibility of destroying the program in operation flow. 

TABLE 6-1. Input Criteria Window Menu - rC-- 
FILE M- CUSTMR UTKlTY HELP 

New Project Pick up (Logging) Next - F11 Stan Foreground Color Assistance 
Open Project Slack off (Logging) Previous - F1Z Background Color About 
Save Project Pick up (Drilling - Tripping) First Monochrome 
Save Project As... Sleck off (Drilling - Tripping) Last English 
New File Drill Metric 
Open File Consider Hydraulic While Tripping Wellbore 
Save File 
Save File As... 
Print v-, 

Current Page 
All Peges 

Exit 

TABLE 6-2. Output Window Menu 

I WlNWW I G R ~ W  OPTION I HELP 11 
Print ReportlGraph Only 
Print Project File 

Print WDI and SDI File 
Print TDI and PDI File 
Copy Graph to Clipboard - Save Report Disk File 
Beck to Input 

f l  Exit 

Cascade - Shift FS Curve Option Assistance 
Tila - Shift F4 Image File Format v-, About 

Bitrnap 
Metafile 

Average Icons 
All 
Equivalent Stress 
Hydraulic Pressure 
Axial Drag 
Surface Load 
Bonorn-Hole Pressure 
Data Table 
Bi-Axial Graph 



6.2 GETTING STARTED 

Bring up W i  ad dect "DEA APPLICATION GROUP as the active winbnv, as shmn in F- 6-1. 

Figure 6-1. "DEA APPLICATION GROUP" and CSTRESSl Icon 

This window may contain more than one icon. Double-click on the CSTRESSl icon, the 
INTRODUCTION window with two command buttons, "Exit" and "Continue" will be displayed on the screen. 

Figure 6-2. Introduction Window 
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- 
Clicking "Exit" will terminate the program. The "Continue" button is the default wmmand which means - 

that the user can press the button by pressing CENTER > or clicking the mouse. This will invok and display - the INPUT Window. Note that after the INTRODUCTORY Window appears, it takes a few seconds for the 

wmmand buttons to be responsive; it is loading necessary files. 

6.3 PULL-DOWN MENUS IN THE INPUT WINDOW 

The CSTRESSl menu system provides many tools that the user will utilize while running the application. 

As in other Windows applications, the user can pulldown a menu by clicking the menu name with the mouse, 

or by pressing the Alt key on the keyboard and then striking the first letter or the underscored letter of the menu 

name. Once a menu is displayed, the user selects a wmmand by clicking the command name with the mouse 

or by highlighting the command name and pressing CENTER > . 

There are six menus in the INPUT Window: File menu, Model menu, Page menu, Run menu, Customer 

Utility menu, and the Help menu as shown in Figure 6-3. 

- Input - lCrlterls Wlndnwj 1-11 

B l c  Model h Q e  Bun Cuetorncr !)tillD/ Help 
P-1 d 5  

Figure 6-3. Input Window 

The page number is shown on the right-hand side below the menu bar. These five pages are illustrated 

in detail in the next section. The Page, Run and Help menus are enabled for five pages. Model and Customer 

Utility menus are enabled only on the first page. However, the last item "Wellbore" under Customer Utility 

can be selected only on the fifth window page. 

For the File menu, the four commands on project file ("New Project," "Open Project ...," etc.) are 

enabled only on the first page while the four commands on file ("New File," "Open File ..." etc.) are enabled 

only on pages 2 through 5 of the INPUT Window. 



The F i e  menu contains commands for creating, retrieving, saving and printing input data as displayed in 

Figure 6-4. 

Figure 64. File Menu 

- Input - [Cflterla Wlndowj 1 - 1 :  
B l e  Model Page Bun Customer utility Help 

When the user starts CSTRESSl, it automatically opens a new project (by default: Projectl.CDR) and a 

set of input data files, namely, Projectl.WD1, Projectl.SD1, Projectl.CT4 Projectl.CP4, all in the current 

subdirectory. The reason for using the project file is for quick, future retrieval of a set of input data. The user 

can open an existing project file without opening each individual (.WDI, .SDI, CT4, .CP4) file. The project 

file, which is a collection of the paths and file names of all input data files, will do the rest of the retrieving 

work for the user. 

Mu Role& 
m e n  Prolea.. 
Say+ R o l e d  
S- R ~ j c d  b.... 

N w  File 
Open File ... 
Save flle 
Sawc n l e  &... 
WnL.. b 

E a t  

However, although the listing in the CRITERIA Window (Page 1) represents files, CSTRESSl does not 

automatically create files on the disk when the user starts CSTRESSl. The same is true with "New Project." 

Only when the user chooses one of the Save commands from the File menu does CSTRESSl actually save 

something to disk. 

P a s m l d 5  

1. "New Project" command clears every input data file and displays a set of null input data files with 

default names in the CRITERIA Window. 

- Input - ICrltcria W n d 4  1 - 1 :  
Model Bun Customer Utility Help 

P-1 d l  

gpen projea.. 
Sayc R o l e d  
Ssvp R o l e d  b... 

Open Flle.. 
Saw nit 

2. "Open Project.. ." command opens a dialog box which enables the user to explore the file system for 

input files with extension name ".CDR." 



3. "Save Project" command replaces the previous version of each of the input data file in the project with 

the modified one. Note that the project file (.CDR) does not contain any input data. It is simply a list 

of all the input data files in the project. That list is updated every time the user saves the project. 

4. "Save Project As ..." wmmand opens a dialog box. The user can specify the drive, directmy, and the 

name of the project file. 

5. "New Fie" wmmand clears every enby box asxiated with the current page, (i.e., om of WDI, SDI, 

CT4, CP4 files). 

6. "Open F ie  ... " wmmand opens a dialog box which enables the user to explore the file system for input files 

with extension name which is determined by the current page the user is in. For example, in page 2, the 

user clicks the Open File.. .; the pattern for the file list box in the dialog box will be " .WDI. " 

7. "Save Fie" command replaces the previous version of the input data file. 

8. "Save Fie  As ..." command enables the user to save a file under a new name the user specifies wfiile also 

retaining the original file. The mw file will be associated with the project file when the user saves the 

project. 

9. "W' wmmand allows the user to print the b u t  data of the current page or all pages. 

10. "Exit" command terminates the current application. CSTRESSl will prompt the user to save the 

files, if they are not saved. 

The files that make up a project do not have to be in one directory on the hard drive, since the project 

records the detailed path information on each input file. A single file such as an SDI file can be part of more 

than one project. However, if the user renames or deletes a file outside of the CSTRESSl application and then 

rum CSTRESSl ad hies to upen the file, CSTRES1 displays an error message to warn the user h t  a tile is mising. 

The Model menu contains commands for five different coiled-tubing operations as displayed in Figure 6-5. 

Figure 6-5. 

- Input- fCrtterla Wlndowj 1-10 
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1. "Pick Up (Logging)" operation allows pick up of the wiled-tubing string with the logging tool 

connected at the end. 

PI& up [Logging1 
J Slack o l  [Logging] 

PI& up [Orllllng-Trlpplngl 
Slack o l  [DrillinrTripping] 
Orill 

I JConsider hydraulics vhile tripping 

2. "Slack Off (Logging)" operation allows the wiled-tubing string to be run into the well with the 

logging tool. 

P a p e l d 5  



3. "Pick Up (Drilling-Tripping)" operation allows pulling the coiled-tubing string together with the 

bottom-hole assembly out of the well. 

4. "Slack Off (Drilling-Tripping)" operation allows slack off of the wiled-tubing string with BHA. 

5. "Drill" operation simulates the drilling operation. 

6. "Consider Hydraulics While Tripping" tells the program to calculate only the hydrostatic pressure or 

to calculate surge and swab pressures (pick-up, slack+ff operations) and circulating pressure (drilling 

operations). The check mark has to be at the front of this command or it will only calculate hydrostatic 

pressure. 

The Page menu contains commands for browsing and navigating through the five pages as displayed in 

Figure 64. 

- Input - [Criteria Wlndw 1-10 
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Figure 6-6. Page Menu 

1. "Next" command leaves the current page and goes to the next page. Before doing so, the program 

will first check the validation of the input data in the current page and asks if the user wants to correct 

the invalid data entry. Then it will prompt the user to save the current file if it has not been saved. 

2. "Previous" command functions the same as "Next" wmmand, but in the opposite direction. 

3. "First Page" command leaves the current page and goes to the CRITERIA Window. It will check the 

input data and prompts the user to save the file if the file on the current page is not saved. 

4. ''Last Page" command leaves the current page and goes to the PARAMETER DATA INPUT Window. 

Itwillcheckthe~t&fdardpro~theusertosdvethefileifthefilemthe~rdpageknot~dved. 

Usually, if all data are matched and consistent, the user will have no problem leaving one page for 

another. However, in some cases, the program will prompt a warning message even though each individual data 

page is good. One possibility is that an existing file is opened on the first page (Criteria page), and the user 

moves to the last page without going through the preceding pages. The program has no knowledge of the 

vali&tionofthedatainprecedingfiles. Inthiscdse,goinp~theprecedingpgeswillk~deartheconfudon 

The Run menu contains the command that the user chooses when ready to start calculation. The "Start" 

command does just that. The user can start the calculation from any page. The program will check the 

validation of all data. 



"-- The Customer Utility menu contains the command that enables the user to select the color, unit, and - wellbore schematic. 

Figure 6-7 shows this menu. 

Figure 6-7. Customer Utility Menu 

- 

1. "Background Color" command opens the "Color" dialog box, which will let the user select the 

desired background color. 

2. "Foreground Color" command opens the "Color" dialog box, which will let the user select the 

desired foreground color. 

3. "Monochrome" command allows the CSTRESSl program to run with a monochrome monitor. 

4. "English" and "metric" menu allows the user to select the desired unit. 

5. "Wellbore" command shows the wellbore schematic. 

The Help menu gives the user information about the assistance and computer systems. 

Input - parameter Dola Input Wlndow] 1 - 1 :  

Figure ,643 shows this menu. 

- 
Pie ~ o d c l  P s ~  Bun Customer Yuhty Help 

Assistance... 
About.. 

Elle Model @ge Bun Cuslomer W l h y  Help 

Figure 6-8. Help Menu 

( 

1. "Assistan ce..." command opens the "Assistance" dialog box, which displays MEI's address, phone 

number, and other applicable information. 

2. "About ..." command opens the "About" dialog box, which gives the user instant reference 

information about CSTRESSl and current computer system information. 

Farcgraur~d Color 
Background Color 
Mr~nachramc! 

JEngllsh 
M~:blc 

Wcllborc ... 

P a s a 5 d 5  



6.4 THE INPUT WINDOW 

In the INPUT Window, there are five pages according to different input data files. These five pages are: 

1. CRITERIA Window 

2. WELL DATA INPUT Window (WDI) 

3. SURVEY DATA INPUT Window (SDI) 

4. TUBULAR DATA INPUT Window (TDI) 

5. PARAIvETER DATA INPUT Window (PDQ 

When the user leaves each page, except the first page, the program automatically checks for input errors 

on that page. 

6.4.1 Pave 1: Criteria Window 

Figure 6-9 shows a typical CRITERIA Window. The paths and names of input data, their saved 

status (Saved or Not), CT operating model, hydraulics consideration, and the unit system currently in use is 

displayed on this page. 

- Input - ~Cl le r l a  W l n d w  1 - 1 :  
Dle Model I?aoe Bun Customer &illll(y Help 

P a l  d l  

Coiled Tubiug Stress Anelysis Model iCStress) 

Rojecl file: CAvs\cn(TESr.CSr (*) 

Well Data lnput file: C.1vs\CkRTEST.WDI (+) 

Survsy Data lnput file: C\vs\cn(TEST.SDI (+) 

Tubular Data lnput file: C:\vs\cn(TEST.CT4 (*) 

Parameter Data lnput file: C:\vs\MTEST.W4 (+) 

Model Selection: Slack ofl (Logging) (Consider Hydraulics) 

Unit System Used: English 

Note: (+) - Saved. (-) - Not saved 

Figure 6-9. Criteria Window 



6.4.2 Page 2: Well Data I n ~ u t  (WDn 

Figure 610 shows a typical WELL DATA INPUT Window. 

- Input - w e l l  Data Inpul W l n d M  1-1:  
~I IC ~ o d e l  B i l e  Bun cuol~mer lltlltly Help 

P l p s 2 d 5  

I I 

Figure 610. Well Data Input Window 

Company Name : 
Project Name : 
Well Name : 
Well Field : 
well city1 State : 
Dale : 
Comments : 

- 
The user is asked to input a series of strings representing the company name, project names, well 

location, data, and comments. They are optional and need not be completed. They will not be used in - - calculation or in the file name specification. 

Maurer Engineering Inc. 
DEA 67 
S limhole 
Coiled Tubing 
Houston Texas 
1993 Apr 
Example 

The strings must be less than 30 characters in length. 

6.4.3 Page 3: Survev Data Innut (SDn 

Figure 611 shows a typical SURVEY DATA INPUT Window. 

- 
@le ~ o d c l  b i l e  Bun cuotomer lltlltly Help 

P a w 3 d 5  

Figure 6-1 1. Survey Data Input Window 

6-9 



The user can input up to 400 survey data points. The measured depth, inclination angle and 

azimuth angle each have two unit options, independent of the application unit system the user selected for the 

application. 

When the cursor is in the text box, press the + or -. key to move the cursor inside the box to edit. 

Pressing the t or 4 key will move the cursor to the above or the lower box. If the user wants to move the 

cursor to the right or left box, hold down the Ctrl key and press -. or +. Of course, the user can use the mouse 

or press the tab key to locate the cursor. 

The SDI files used in CSTRESSl are compatible with any SDI files in other DEA software 

applications developed by MEI. 

The tortuosity command button lets the user torture the smooth survey data, so that the doglegs add 

to the original survey. See Section 6.8 for details. 

6.4.4 Page 4: Tubular Data I n ~ u t  (TDI) 

Figure 6-12 shows a TUBULAR DATA INPUT Window. 

- Input - vubular DaE. Input W n d m ]  1-1:  
n l e  M O ~ C I  p g e  Bun CuBlorncr Utlllty Help 

P l p s 4 d 5  
SDI TYD [HI 8000.0 W d  Y.D. BI 

Figure 6-12. Tubular Data Input Window 

The spreadsheet-like Tubular Data table is similar to the SDI file input, but TDI uses grids instead 

of text boxes which are used in SDI. 



- 
Depending on which model has been selected, the user can input only a fraction of the data 

,- 
window. The TDI Window groups the same type of input data and places them into frames. For example, if - the user selects the slack off (logging) model, the nozzle and weight+n-bit information is not needed on the 

saeen ' I he t i decdoro f the~~hmegmupbecomesgrayshad ing .  Theusercanmtaccesshesedata. 

BHA and CT string data are input into the Tubular Data table. The Tubular Data table input starts 

from bottom tool (BHA) to the surface. While the user edits the section length, the program continues to track 

the accumulative length of the CT string and BHA, then displays the accumulative length (i.e., Well MD) in the 

upper center of the screen. When the user selects the logging model, the logging tool length with the CT string 

length andlor BHA length becomes the Well MD. 

At the top right-hand corner of the TDI Window, the program displays the SDI TMD which is the 

total survey measured depth input in the previous SDI Window. The Well MD must be smaller than or equal 

to the SDI TMD. 

Sometimes when the user switches from one unit system to another, the previously compatible data 

may become unmatched due to the rounding off of the data during the conversion operation. Mostly this happens 

on measured depth in the SDI file and bit depth in the TDI file. Remember that the unit for measured depth in - the SDI file may be different from the one in the application unit system. 

If the user clicks the Database command button, the program opens the disk database file. The - -. default file name is CDDB.DB. 

- Input- rubular D a b  Inpul Wlndm] 1-1: 
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Figure 6- 13. Open CT Database File 
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Click the OK button, the coiled-tubing database shows on the screen. The user can edit the data 

and save the changed data on the disk file. After finding the data, click the OK button, this will copy the dam 

to the TDI table. - 
- Input - Fubular Data Input Wlndmr] 1-1: 
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Figure 6-14. Coiled-Tubing Database 

The PDI Window also provides the casing database (Figure 6-15). 

Figure 6-15. Casing Database 
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The default database file is CSGDB.DB 

6.4.5 Page 5: Parameter Data Inout PDll  

Figure 6-16 shows a typical PARAMETER DATA INPUT Window. 
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Figure 6-16. Parameter Data Input Window 

In PDI the user finds the same input styles as in TDI, the data are grouped by frames. Some of 

these frames can only be accessed with certain operating model selection. 

Well interval input sections are from surface down. When the check box is left empty in the 

"show porelfracture pressure," the program does not consider porelfracture pressures. 

In the calculation option frame, there are three options that will affect the results of the calculations. 

The formulas for these calculations are discussed in Chapter 2 "Thwry and Equations." 



Pulldown the Customer Utility menu, select the wellbore option and the wellbore schematic will 

be displayed on the screen (Figure 6-17). 

Figure 6-17. Wellbore Schematic 

The wellbore graph is only available on the PDI screen page. 

6.5 SAVE INDMDUAL FILES 

The user can save WDI, SDI, TDI, and PDI files individually. While the PDI page is on the screen pull- 

down the File menu, the user can openlsave the PDI file to a diskette. It is the same as managing other input 

pages. 
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Figure 6-18. Manipulating with PDI File 
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6.6 RUN 
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After examining all input files, select operation model and check the calculation options, then click Run 

and Start to onset the calculation. There is an alerting window that displays on the screen while the program 

is calculating. 

6.7 OUTPUT WINDOW 

When the calcuktion is finished, the program unloads the INPUT Window and displays the OUTPUT Window. 

"Child" windows are employed to display text reports, graphs for various calculation results. A "child" 

window is a window confined to its "parent" window - the OUTPUT window. "Child" windows can be 

displayed independently. The user can manipulate them just as normal windows: move, resize, close, etc. The 

arrangement commands in the Window Menu (Cascade, Tile, Arrange Icons) have the same functions as those 

of the Program Manager of Windows itself. 



There are six "child" windows within the OUTPUT Window. These windows display on the screen in 

the file format automatically. They are: 

1. Equivalent Stress (static) - graph 

2. Hydraulic Pressure (static) - graph 

3. Axial Drag (static) - graph 

4. Surface Load (dynamic) - graph 

5. BHP (dynamic) - graph 

6. CSTRESS Data Report - table 

Use the mouse to click any of the "child" windows, then the "child" window bewmes activated and the 

title bar background wlor changes. Only one "child" window can be activated at a time. The CSTRESS Data 

Report Window will show data for the graph in the active "child" window. 

Figure 6-19. Output "Child" Window 

6.7.1 Print Results 

To send results to the printer: I) activate the desired "child" window, 2) pulldown the File 

menu, and 3) click "Print ReportIGraph Only. " 



Figure 6-20. Pull-Down File Menu 

r 

The user can print the input data by selecting "Print Project File," "Print WDI and SDI File," 

and "Print TDI and PDI File." If "Save Report Disk File," is selected, the data in the CSTRESS Data Report 

"child" window withtwithout TDI and PDI data will save to diskette. 

- 

Copying the active graph to the clipboard can put the graph image to clipboard, and this graph image can 

be retrieved by certain window graphic programs, such as Window-Paintbrush. 

Output 1.1: 

6.7.2 Mani~ulatini! the O u t ~ u t  G r a ~ h  

Under Graph Options - Image File Format pulldown menu there are two types of graphic file 

formats: Bitmap and Metafile. 
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Figure 6-21. Graphic Image File Format Selection 

One difference between Bitmap and Metafile is that Metafile is resizeable. After selecting Metafile 

and copy graph image to clipboard, open Windows Utility: Clipboard Viewer and change the size ofthe Viewer 

window. Graph size proportions itself to the window size. 

To enlarge the size of the graph in the OUTPUT Window: 

1. Activate the sub-window by clicking any where inside the window (the title bar of active sub- 

window is in color). 



2. When the mouse cursor is moved to the boundary of the sub-windows, the cursor becomes 

a double arrow (Figure 622). 

3. Hold left button of mouse, then drag the boundary to the size you want. 

4. For a full-screen graph, click the maximize box in the topright corner of the sub-window. 

NOTE: It is impottant to change the size of the graph on the screen because the size of the 
p W d  graph depends on the size of the graph on the screen. 

- output 
ale yylndm Graph Qpllon Help 

Figure 6-22. Change Graph Size 

If the user selects Window - Cascade from the pulldown menu, the "child" window (only the 

visible "child" window) in the OUTPUT Window becomes CASCADE. 



.- Figure 6-23. "Child" Window CASCADE 

6.7.3 Select Out~ut G r a ~ h  Curve 

- ,- When the calculation is finished, all output graphs with whole set curves will display on screen. 

Not every curve is important to the user, so the program provides the option of presenting the desired curve on 

the graph. Select Graph Option - Curve Option pulldown menu, CSTRESS's Graphic Curve setting will - 
display on the screen. 
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Figure 6-24. Graph Option - Curve Option Pull-Down Menu 
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Choose the desired curve by clicking the mouse at each check box (mark an x in each box), then 

click the OK button and the program redtaws each graph. 

6.7.4 Bi-Axial Grauh 

To examine the bi-axial and API stress for each coiled-tubing section, pulldown the window menu 

and select Bi-Axial Graph. The Bi-Axial stress graph displays on the screen. 

Figure 6-25. Bi-Axial API Stress 

Depending on TDI input, the right-hand side of the program lets the user examine each input CT 

string section. NOTE: the TDI input program &ws up to fifteen strings but only &ws ten strings in this 
window. The numbers printed to the right of the string order number is the measure depth range of each section 

and shows string information at the bottom. 

Although the program shows triaxial stress calculation results on the Equivalent Stress (static) graph 

and in the CSTRESS Data Report, the biaxial stress criteria is still required here to draw the ellipse. The upper 

part of the ellipse is based on zero outside pressure and the lower part of the ellipse is based on zero inside 

pressure. The pressure data used to draw the inherited pressure-stress curve for each pipe section, are the 

difference between inside and outside pressure. If the inside pressure is greater than the outside pressure, the 

program uses the pressure difference to check the pipe in burst consideration. If the inside pressure is less than 

the outside pressure, the program uses the pressure difference to check the pipe in collapse consideration. For 

example, if the outside pressure is 4000 psi and the inside pressure is 1500 psi, the program uses 3000 psi (= 

4000 - 1000) outside pressure and zero inside pressure to draw the pipe curve and the user can examine the 

biaxial and API stress in collapse. In Figure 6-24, the curve of the pipe is inside the curve of the biaxial and 

API which implies the pipe inherited stress is less than the yield stress. 



- 
6.7.5 P u m ~  Eaui~ment - 

The tubing pressure data shown in the graph and output report are for wiled tubing that is inside - the wellbore (i.e., below the BOP). For coiled-tubing operation, the mud pump is connected to the reel. Certain 

lengths of wiled tubing remain on the reel. When mud is pumped through the coiled tubing remaining on the 

reel, there is extra pressure loss on this section of the tubing. To calculate pressure loss and find the required 

output pressure and horsepower of the pump, pulldown the window menu and select PUMP EQUIPMENT. 

The PUMP EQUIPMENT Window displays on the screen. 

- output 
Ble Wndw GraphPpHon Help 

Figure 6-26. Pump Equipment Window 

Most input data for the PUMP EQUIPMENT Window comes from previous input and output data. 

The user can edit any of the input data. After the input data are satisfied, click the calculate button and the 

output data is shown on the screen. Click the go back button and the PUMP EQUIPMENT Window is closed. 

6.7.6 Exit O u t ~ u t  Window 

To leave the OUTPUT Window, pulldown the File menu, select "Back to Input." This takes the 

user back to tbe INPUT Window to edit input data, deu "Exit" lhis exits tbe program ad goes back to MS Wirdows. 



6.8 USING TORTUOSITY 

When the Survey Data Input (SDI) page is loaded into the INPUT Window and the survey data has been 

created, click the tortuosity command button and the TORTUOSITY Window displays on the screen. 

Figure 6-27. Tortuosity Command Button 

- Input - ISurvey Data Input Wnndowl - 1 :  

Figure 6-28. Tortuosity Window 
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.- At the top of the TORTUOSITY Window, there are two "child" windows: 1) Survey Data Table and - 2) Tortuosity Dogleg Graph. At the bottom of the TORTUOSITY Window is the data input area. 

The survey can be divided into as many as five zones (for example: surface to KOP, first build section, 

first tangent section, second build section, and second tangent section). Each survey zone may then be given 

a different amplitude for its distributed tortuosity. The bottom measured depth is always equal to the maximum 

survey depth. The period data is the length of one sine wave cycle. The user can input the desired tortuasity 

cycle. Sometime the survey data density is low and the user can click insert stations and the program hats  more 

s~itim betmen the two oriw survey siatiors. The ckhult k r t  station inknal length is 100 ft 

Figure 6-29. Tortured Survey 
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There are five command buttons at the bottom: 

1. Calculate - tortures the original wellpath, and both the survey data table and dogleg severity graph 
shows the tortured survey. 
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2. Un-Do - resets the data to the original survey data. 

1: 

3. Print <F6> - prints the active window. If a table or graph is displayed on the screen and the 
print command button cannot be seen, press the <F6> function key to execute the print 
command. 

4. OK - copies the tortured survey data to the SDI file in the SDI Input screen. 

5. Cancel - leaves the TORTUOSITY Window without any changes in the SDI data. 

Both tables and graphs can be enlarged. 



Figure 6-30. Tortured Survey Data and Dogleg Graph 

6.9 CSTRESS HELP AND DIALOG BOXES 

There are five types of dialog boxes associated with menus: Assistance dialog box, About dialog box, F i e  

Open dialog box, File Save dialog box, and Color dialog box. 

6.9.1 H e l ~  - Assistance.., 

When the user selects the "Assistan ce..." command from the Help menu in both INPUT and 

OUTPUT Windows, the following dialog box appears (Figure 6-31): 

I For asslstanccwlth thls program, contact 1 
Lcc Chu 

or 
Gefei Liu 

I Maurcr Englnccrlng Inc. 
2916 Wcst1.C. Jester I 

Fhonc: 713-683-8227 
F a x  713-6836418 
Tclcx: 216556 

Figure 6-31. Help - Assistance Dialog Box 
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,- 6.9.2 # ~ I D  - About.., - When the user selects the "About.. . " command from the Help menu in both INPUT and OUTPUT 

Widows, the following dialog box appears (Figure 6-32): 
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- Figure 6-32. Help - About Dialog Box 

6.9.3 O ~ e n  Proieet and Data File - 
When the user selects the "Open Project" or "Open File" from the F i e  menu in the INPUT 

Window, the following Open dialog box appears (Figure 6-33): - P 
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- Figure 6-33. "Open Project" Dialog Box 

This dialog box enables the user to search the file system for the desired files with the extension 

- ".CDR." The extension name (.CDR, .WDI, .SDI, .CT4, .CP4, .DB, etc.) is chosen automatically by the 

program to determine the type of file that will be opened in the different windows. 

- The user can move behveen sections of the dialog box by simply clicking on the desired section. 

Alternatively, the user can press the <TAB> key from keyboard until the focus moves to the desired section. - 



There are four list boxes: the drive list box, the directory list box, the file list box, and type list 

box. Wufimctiorsare~ibedbelow. ' I h e r e i s o r ~ t e x t b o x a r d t w o c o m m a r d ~ :  OKardCANCEL. 

1. The Drive List Box 

On the lower right corner is the dropdown drive list box. In its normal state, it displays the 

current drive. When the user clicks the arrow at the right of the drive list box, it drops to list 

all valid drives. The user can activate a new drive by singleclicking the desired one. 

2. The Directory List Box 

The directory list box displays the hierarchy of paths of the current drive. The current 

directory appears as a shaded, open-file folder; directions above it in the hierarchy appear as 

a nonshaded open-file folder, and those immediately beneath the current directory are closed- 

file folders. The user can change the directory by double-clicking the selected one. Note that 

in the directory list box, a single click only selects (highlights) he  item; a double click is 
required for the command to be performed. 

3. The File List Box 

The file list box displays the files in the current directory. The file names shown are those 

specified by their extension name "CDR." A single mouse click on an item makes it appear 

in the "File Name" text box. If the user chooses OK at this time, the data file is retrieved 

and all data related to the current calculation mode are displayed in appropriate entries. 

Double-clicking the selected file has the same effect as above. 

When the user selects a new drive, the directory list box is updated, which then causes the 

file list box contents to be updated. When a new directory is selected, the file list box is 

updated, but the drive remains the same. 

The path specification label always represents the current path information. 

4. The Type List Box 

This list box is set by the program. The user cannot change it. It specifies the type of files 

that are to be displayed in the file list box. In this "Open Project.." dialog box, the type of 

file is "*.CDR." 

5. "File Name" Text Box 

The application should also do the following when the user enters text in the "File Name" 
text box and then presses < ENTER > . 

If a drive letter is entered, the drive, directory, ard file list boxes shuld be updated. 

If a directory path is entered (for example, "\CSTRESSH), the directory list box 
and the file list box should be updated accordingly. 

If the name of an existing file (with extension name ".CDRW) is entered, the 
dialog will be completed and the files will be retrieved. 



6. Command Buttons 

If the existing file name is shown in the text box, pressing OK will complete the dialog and 

the data file will be retrieved and displayed. 

If the CANCEL button is pressed, the dialog is cancelled and no information is made 
available to the application. 

6.9.4 Save Proiect - Data File - When the user selects "Save Project As" or "Save File As" commands form the File menu in 

the INPUT and OUTPUTWindows, the following dialog box appears (Figure 6-34): 

1 - 1  Save SDI Wc As... 

Figure 6-34. "Save File" Dialog Box 

This dialog box is almost identical to the "Open Project" dialog box in appearance; however, the 
filter in the type list box is different. Depending on the file the user is manipulating, the filter in the type list 
box will be a ".CDR," ".WDI," ".SDI," ".CD4," or ".DB," etc., extension. 

6.9.5 

When the user selects one of the commands on color from the Customer Utility menu in the 

INPUT Window, the following dialog box appears. 

-1 Color 
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Figure 6-35. Color Dialog Box 

The Color dialog allows the user to select a color from a palette or to create and select up to 
sixteen custom colors. 



6.10 CSTRESS ERROR HANDLING 

When input data on a page are outside the appropriate range of values and the user tries to leave the page, 
the CSTRESS error checking routines will locate the error. The application will then display an error message 
explaining why the data are not acceptable. The user can ignore the error message and leave the page even 
though the data on the page do not make sense. This enables the user to edit and view different input pages 
without having to complete one before going to another. 

The user can start calculation from any page. If any invalid data are found at this time, the application 
will display an error message and force the use to go to the page with invalid data for editing. 

When an error message appears, click OK or press <ENTER> to return to the associated page in the 
INPUT Window. 

6.11 QUICK START 

Use the following procedure to get started with the CSTRESSl program. 

Install: 

1. Start Windows (3.0 or later version). 

2. Insert Disk into drive A:. 

3. In the File Manager, choose Run from the File menu. 

4. Type A:setup and press Enter. 

5. Follow on-screen instructions. (Please use the default subdirectory). 

Run: 

6. Double-click the CSTRESSI iwn. 

7. In the first window (INTRODUCTORY Window), click "Continue" after it becomes responsive. 

8. In the INPUT Window, choose "Open Project.. ." from the File menu. 

9. From the "Open CDR File" dialog box, click the drive C: in the drive list box, double-click the 
"CSTRESS" subdirectory, click the "TEST.CDRW in the file list box, and then click OK. 

10. Click "Next" from the Page menu to view other pages of input data (WDI, SDI, TDI, PDI). 

11. Click the "Start" from the Run menu. After calculation the OUTPUT Window is loaded. 

12. In the OUTPUT Window that follows, select the text report or interested graph windows under the 
"Window" and "Graph" options of the menu to view the output. 

13. To print the text report or graph, make the corresponding "child" window active, select "Print 
RepodGraph Only" from the File menu. 

14. Choose "Back to Input" from File menu to return to the INPUT Window or choose "Exit" to 
terminate the application. 
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8. BUG Report or Enhancement Suggestion Form - - Name: Company: 

- Address: City: State: 

Phone No.: Fax No.: Date: 

Bug\Problem Report Enhancement Suggestion 

Program Name and Version Number: 

Bug\Problem Description or Enhancement Suggestion: 

Regarding the Bug Report, please answer the following questions: 

Comvuter Svstem Brand: 

Chip: 286 386 486 Pentium 

Type: Desktop Laptop Notebook Other 

RAM: - MB 3.lsd: MHz 

Math-Co~rocessor Present: yes No Unknown 

Printer Type: (for printing error only) 

Plotter: (for plotting error only) 

Within Network System: yes  No Type: 

Video Type: EGA VGA SVGA Mono LCD 

Video Card Ram: (video problem only) 

Overatinp Svstem 

MS-DOS Version No.: MS-Windows Version No.: (for Wiowsapplications) 

OS2 MS-Windows NT Version No.: 

Other 

BUG detect in^ Data 

17 Will be mailed on diskette Will be faxed Attached None 

Other Comments: 

Please send or fax to: I Lee Chu 
~ U R E R  ENGINEERING INc. 

2916 West T.C. Jester 
Houston, TX 77018-7098 




